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Introduction 

Overview 
The 411 document was created for those items users commonly inquire about. 

Contact Information 

EFI Support 

US Phone: 855.334.4457 (first select option 3, then press option 8, then press option 1) 

US Fax: 415.233.4157 

US E-mail: printstream.support@efi.com  

Regular Service Desk hours are 8:00 AM to 7:00 PM Central Time, Monday – Friday. Outside of these hours, 
you may leave a voice mail message and an on-call support representative will be paged. Response time is 
based on the severity of the issue. 

Note For problems involving infrastructure (i.e., computers, networks, operating systems, backup software, 
printers, third-party software, etc.), contact the appropriate vendor. EFI cannot support these types of 
issues. 

EFI Professional Services 

US Phone: 651.365.5321 

US Fax: 651.365.5334 

E-Mail: ProfessionalServicesOperations@efi.com 

EFI Professional Services can help you perform EFI software installations, upgrades, and updates. This group 
can also help you implement, customize, and optimize your EFI software plus offer a range of training options. 
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Printing Barcodes 
Reports that print the Barcode for Inventory Items  

 Inventory Reports  House Keeping  Inventory Barcodes Printing 

 Inventory Transfer  Print Skid Tag 

 Inventory Manager  Housekeeping Skid Tag Reprint (to print for all items / Skids) 

Reports that print the Barcode for Inventory Locations  

 Inventory Reports  House Keeping  Inventory Barcodes Printing 

 Inventory Transfer  Print Skid Tag 

 Inventory Manager  Housekeeping Skid Tag Reprint (to print for all items / Skids) 

Reports that print the Barcode for Skids  

 Inventory Transfer  Print Skid Tag 

 Inventory Manager  Housekeeping Skid Tag Reprint (to print for all items / Skids) 

Transactions which prompt for Skid Ticket printing 

 Inventory Manager  Regular Issue  after issue  Print Skid Ticket  

 Inventory Manager  Receiving Customer 

 Inventory Manager  PO Receipt 

 Inventory Transfer  After Skid Transfer 

 Inventory Transfer  After Skid Adjustment 

 Inventory Transfer  After Skid Destroy or Recycle 

 Inventory Transfer  Merge / Split skid 

Reports that print the Barcode for Request ID’s 

 Inventory Requests  Issue Request 

Reports that print the Barcode for Job Numbers 

 Print WO  Print Work Ticket 

Reports that print the Barcode for PO Numbers 

 Feature not available right now 

Reports that print the Barcode for Pick ID’s 

 Fulfillment  Pick Confirmation  Print Pick Slip 
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Print a Barcode Using Print 128 Program 

 

The Print 128 program (found as a stand-alone program in PrintStream) will print a number of barcodes for use 
in scanning transactions into PrintStream. The printed barcodes can be printed one at a time or multiple 
barcodes to a sheet. There is also a feature that provides you with a list of all cost center machines when the 
machines are set up in MR Shop Supervisor and a list of all activity codes in a cost center. 

The Print Standard Command Sheet includes a sheet that can be displayed at the workstation for all standard 
commands used in the MR Shop Floor program. 

 

The employee ID barcode represents an E: followed by the employee code (up to 8-digits, alpha and/or numeric) 
entered in Master Files – Employee (E:12345678). 

To print an employee barcode (or other barcode) 

1. Locate and click the Print 128 module. 

2. Enter the code in the appropriate field. 

3. Click Print then Done. 

To print several codes on one page 

1. Enter the code and click Print. 

2. Enter the next code and click Print. 

3. Continue process until complete. 

4. Click Done. 

 After clicking Done, the page(s) will automatically print to your default printer. 
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Print 128 Standard Command Sheet  

Print 128 allows the user of Wireless Warehouse to scan bar codes for the “Next Item” and “Next Box” 
functioning of the QC Pick Confirmation programming.  Print128 program has the “Next Item Button” bar code 
and the “Next Box Button” bar code added to the ‘Standard Command Sheet’.  The user can therefore now scan 
these bar codes after entering the item and quantity information in the Wireless QC Pick Confirmation program.  
Previously the user was only able to proceed by clicking the “Next Item” and “Next Box” buttons.   
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Buyout Bids 

Where Are the Buyout Bids Records Stored? 

 

QTT_SUBBIDSHDR 

There is one record in this table for every buyout process for every vendor. 

So if you had 1 outside process on a job and had sent bids to 3 vendors there would be 3 records in this table. 

The BUYOUT_RECNUM points to MAILPROC.DATAFLEX_RECNUM_ONE if the BUYOUT_TYPE says 
“MAILPROC (Mail buyout processes) 

The BUYOUT_RECNUM points to QUOTPROC.DATAFLEX_RECNUM_ONE if the BUYOUT_TYPE says 
“QUOTPROC” or “Quotproc” (Print buyout processes) 
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QTT_SUBBIDSDETAILS 

There is one record in this table for every buyout process for every vendor for every qty. 

So if you had 1 outside process on a job and had quoted 6 quantities and sent bids to 3 vendors there would be 
18 records in this table. 

The fields in this table should also make sense to you and you should be able to see the relationship between 
QTT_SUBBIDSHDR and QTT_SUBBIDSDETAILS 

i.e., QTT_SUBBIDSDETAILS.SUBBIDSHDR_RECNUM = QTT_SUBBIDSHDR.DATAFLEX_RECNUM_ONE 

In this example, however, I have only one quantity on the estimate with three vendor bids, so my total records 
are three. 

 

 

 

 

Data Guide O.E. Job Specification Fields in Print Estimating 

Previous Job Number 
The field in the O. E. Job Specification screen in Print Estimating Previous Job Number is stored in the 
TICKET1 table, LAST_JOB field. 

Film File Number 
The field in the O. E. Job Specification screen in Print Estimating Film File Number is stored in the TICKET1 
table, PLATE_FILE_NO field. 
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Maintenance Wizard for SQL 

Introduction 
Included in this document are housekeeping tasks that should be done on a regular basis to insure SQL 

performance and data integrity of SQL 2000, 2005 and 2008. 
Normally, these functions are taken care of by a Microsoft Certified DBA. Backing up the database, reorganizing 
data and index files, compressing the data file, updating the index statistics, and performing consistence checks 
are a few examples of a DBA role. All of these tasks can be executed using TSQL commands. However, SQL 
2005 includes a graphical wizard (Maintenance Plan Wizard) that makes selecting these tasks and their options 
easy. In addition, the wizard will roll all of your selected tasks into a reusable and customizable package.  

Wizard 

To start the Maintenance Plan Wizard 

1. Open the SQL Server Management Studio. 

2. From inside the Object Explorer, expand the Management folder. (If the Object Explorer is not visible 
from inside the Management Studio, click the View menu and select Object Explorer.) 

3. Right-click Maintenance Plans and select Maintenance Plan Wizard. 

  

4. The initial splash screen for the wizard opens. Click Next. 

5. The Select a Target Server screen opens. Give the plan a Name and select the SQL server it will 
target. 

6. Select the authentication method the plan should use: either Windows or SQL Server. Whichever 
method is selected; ensure the account has enough permission to act on the database. Click Next. 
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7. The Select Maintenance Tasks screen presents a list of all the available tasks the wizard can 
configure. 

  

 All the task check boxes are selected and each is discussed in the order the wizard presents them. 

8. Click Next to open the Select Maintenance Task Order screen. Typically, if there are backups mixed 
with other tasks, the backup should be moved to the top so it executes first, prior to any maintenance, 
just in case data should corrupt during the job. 

 

Database Check Integrity 
The first task, Data Check Integrity, checks the structural integrity of the database. Examples would include 
checking disk space allocations inside SQL, checking consistency between system metadata tables, and 
checking the structures that make tables. For a complete description of what “Check Integrity” means, see the 
Microsoft online article “DBCC CheckDB” located at http://msdn2.microsoft.com/en-us/library/ms176064.aspx. 
This task is extensive and resource intensive. Schedule or execute this action at low production times. Also, 
ensure TempDB has adequate hard disk space available. 

As with most of the wizard screens, an option lets you choose which, or all databases to target. For this article, 
the database AdventureWorks will be used.  

On the screen, there is an optional checkbox that will include or exclude indexes in the check. This example 
included checking them.  
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Shrink Database Task 
This task attempts to reduce the physical size of the database and logs. The value entered into Shrink database 
when it grows beyond will be evaluated when the job begins. If the database size is larger than the entered 
value, the task will execute. 

The next value, Amount of free space to retain, directs SQL server to leave a certain percentage of free space 
in the database. If there were zero free space, then each database write would require the SQL engine to 
request additional disk space from the operating system which would degrade SQL performance.  

Select Return freed space to operating system if you would like any space SQL reclaimed given back to the 
operating system. Otherwise, Retain keeps the space allocated to SQL. 

Reorganize Index Task 
The simple explanation of this task is that the selected index will be defragged. Fragmentation, to quote 
Microsoft, is defined as this: 

”Fragmentation exists when indexes have pages in which the logical ordering, based on the key value, does not 
match the physical ordering inside the data file.” 

For a complete description of Index fragmentation, see the Microsoft article “Microsoft SQL Server 2000 Index 
Defragmentation Best Practices” located at 
http://www.microsoft.com/technet/prodtechnol/sql/2000/maintain/ss2kidbp.mspx . About midway through is a 
section titled Understanding Fragmentation. Excessive Index fragmentation can adversely affect performance. 
The Reorganize Index task will correct this and may improve query response. 

The Object choice lets you specify which type of indexes to reorganize, those that have been created off Tables, 
Views, or both. (In SQL 2005 a View can have an Index, see Books On Line “Indexed Views”). 

Selecting the next task, Compact Large Objects, would only affect the data types Image, Text, XML, and MAX. 

Rebuild Index Task 
This task recreates an index with new settings you define in the wizard. Although this task can reorganize an 
index, like the previous Reorganize Index Task, this task is more suited to changing the Create options on an 
Index. 

The Change free space per page check box determines the percent of free space to leave in each Index Page 
file. (A Page is an 8,192 byte block of space inside the database file.) 

Sort results in tempdb places the working file for a sort during the Rebuild task into the tempdb table rather 
than memory. 

The Ignore Duplicate Keys check box can be used to tell the index to disregard duplicate keys being entered 
during a multiple row insert. 

Keep Index Online, if selected, will allow users to access and query off the existing index while the new index is 
created. 

Conclusion 
The SQL Server 2005 and 2008 Maintenance Plan Wizard offers many core tasks and options for database 
housekeeping your DBA may have additional task he or she may wish to add. It’s very quick and intuitive to use. 
In addition, the packages it creates can be saved and modified.  
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End of Year Procedures 
As many of you are approaching a Fiscal year end, we have compiled a few tips and reminders to help with year-
end closing in PrintStream. 

To close the General Ledger 

1. Prior to entering transactions in 2016, you must define the new year (2016), and its periods in the 
Accounting Period File in the Masterfile Reports program. This is accomplished by clicking Add, then 
modifying month end dates if necessary. 

2. Post all batches, in all modules, for the old year (2015). 

3. Use the Master File Reports program, System Maintenance, Accounts Start Periods menu item to make 
the Open from and To dates to be in the new year, (in other words, close all periods in all modules in 
the year 2015). Close this program when done. 

4. Verify that no users are using any of the Accounting Modules. Open the General Ledger program and 
print a Trial Balance as of Period 12, Year 2015. Make sure that the Trial Balance is in balance for both 
period and year to date. If it is not in balance, do not continue. Contact PrintStream Support. If the Trial 
Balance is in balance, proceed to step number 5. 

5. Start the Forward GL Balances to Next Year utility from the General Ledger Utility menu and confirm the 
Copy from Year is 2015. If it is the wrong year, re-do step 3, close out PrintStream, then return to the 
General Ledger and start the forward procedure again. You cannot modify the year to be forwarded in 
this screen. This information will appear based on the period closing from Step 3. 

6. If the balance forward Credit Amount does not match the total Debit Amount, the report will indicate The 
File is out of Balance. If this happens, PrintStream will not forward the balances into the new year. You 
should close the report and research the period and transaction that caused the out of balance. You can 
also contact Streamline Support for assistance. If the Credit Amount and Debit Amount do match and 
you are in agreement with the period ending balances referenced on the report, print the report for 
future reference, close the report and the balances will forward. The accounts detailed are those that 
have transactions in the new year and include the balances brought forward by the utility.  

7. Many accounting people may expect to see a Journal Entry to close out the year end balances. 
PrintStream does not create an entry but updates the accounts behind the scenes. What you will see on 
your reports, is the year-end balances for the period 12 and the new balance forward balances created 
by the utility. In other words, if your revenue account had a 12/31/2015 balance of $4,000.00, the 
beginning balance in that account will be zero. If the Retained Earnings account had a year-end 
balance of $50,000, then the beginning balance will be the ending balance plus/minus the net of the 
revenue and expense accounts. 

Additional steps for Mail/Postage users: 

This utility should be done as soon as possible after current year end. 

Any postage reports that show a beginning balance will not include balances from the year 2016 until this utility is 
run.  

1. Check each customer’s postage files by running the Postage Audit Adjustment utility (The Hammer), 
selecting items 1 and 2. 

2. Verify that all users are out of the postage modules. 

3. Once you have verified that all customer balances are correct, run the Transfer Customer Postage 
Balances utility from the General Ledger Utilities menu. 

This utility does not verify closed periods/years - but you must remember to re-run it if additional transactions are 
added to the old year. You may re-run this utility as many times as necessary. 
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Questions that we are frequently asked include: 

Q. Can I work in two different years at the same time?  

A. Yes you can. You can begin adding batches and working in the new year even if you haven’t run the year end 
close. However, you will first need to add the new year as described in Step 1. 

Q. Can I run the G/L balance and postage transfer utilities more than once? 

A. Yes you can. You can run the transfer utilities as many times as necessary. 

Q. What if my accountants don’t complete their evaluations until March and have adjusting entries that I need to 
make in the month of December? 

A. You can re-open December, make those entries, post to the General Ledger, re-close and re-run the year-end 
transfer utility even if several months have gone by. 

Logo Size and Definitions 
The recommended logo size is listed below by report: 

 

The logo must be saved as logo.bmp and saved to the icon folder in the stream directory …\Stream\Icons 
folder. 

PrintStream supports the ability to use multiple logos per company, plant and module for the following: 
ARInvoicing, Sales Prebill, AR Reporter/Customer Statements report, Purchase Orders, Postage Advanced 
Letter, Packing Slips and Bill of Lading. This is accomplished by defining multiple versions with special naming 
conventions along with the logo.bmp file. 

The naming scheme is as follows: 

Company Code>Branch / Plant code [Optional]>Module [Optional] (Using the prefix of the Program calling it): 

I = Invoicing 

SP = Sales Prebill 

S = Statement 

PO = Purchase Order 

PA = Postage Advance 

PS = Packing Slip 

BOL = Bill of Lading 

For example: 

Company Code: 01 

Plant Code: 0100 

Module: PO 
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The file name would be Logo010100PO.bmp (Logo + Company Code + Plant Code + Module).  

Custom file names are not required. logo.bmp will be picked up as a default unless a different file name has 
been created. 

Other Examples: 

1. Company Code: 01 

 File Name: Logo01.bmp 

2. Company Code: 01 

 Module: I (for Invoicing) 

 File Name: Logo01I.bmp 

3. Company Code: 01 

 Plant Code: 0100 

 File Name: Logo010100.bmp 

Add Company Logo and Terms to Quote Letter Templates 
To add your Company Logo to the Quote Letter templates, obtain a BITMAP image (300-600 dpi.) containing the 
address, phone #, fax, e-mail address, etc., (approx. W = 4.42” x H = 1.17”) … to check the size in MS Paint, 
select > Image > Attributes. Name file: Logo.bmp. 

 
Place the Logo.bmp. file in the …\Stream\Icons folder.  

Locate 4-files in your database…\Stream\LiveData\Psextern folder and re-name the original files:  

 PAMQLItemizedOrig.dot 

 PAMQLItemizedWithMinOrig.dot 

 PAMQLParagraphOrig.dot 

 PAMQLParagraph6qtysOrig.dot 

Open each file, click the PrintStream logo and delete. Select: Insert > Picture > from File and locate the 
Logo.bmp file in …\Stream\Icons folder.  

Change language on the template if needed and add terms / disclaimer. 

Note  You can turn gridlines on and off using Table > Hide Gridlines / Show Gridlines). 

Save the 4-files as templates in the …\LiveData\Psextern folder: 

 PAMQLItemized.dot 

 PAMQLItemizedWithMin.dot 

 PAMQLParagraph.dot 

 PAMQLParagraph6qtys.dot 
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Master File Employee Security Event to Hide Employee Hourly 
Rate and Cost Fields 

In Menus and Users, create a Role for employees to whom you do NOT want the Hourly Rate and Cost fields 
to display in Master File Employees individual employee screen. In the screen below, the security event is not 
set; therefore, anyone having access to Master File Employees will also have the payroll details of the 
employees. 
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Create Role 
In Menus and Users, select Security > Role > Add Role. 

 

 

Set the User Group (menu) to the User Group that the employee would otherwise belong without the restricted 
employee pay rate data. Check the new Sub Role that was created to set these events (Restricted Employee 
Data). 
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Create the Sub Role 

To create the sub role 

1. In Menus and Users, select Security > Role > Action > Add Sub Role. 

  

2. Enter Sub Role Name and click Save. 

  

3. Highlight the new sub role and right-click and select Add Security Event. 
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4. Find the security event for Master File Employees > Main Screen > Fields > Cost Field. 

  

5. Double-click to add it to the new sub role. Do not select the Read or Write check boxes. Click Save. 
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6. Find the security event for Master File Employees > Main Screen > Fields > Hourly Rate Field. 

  

7. Double-click to add it to the new sub role. Do not select the Read or Write check boxes. Click Save. 
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8. Create the User and designate the Role Employees No Hourly Rate or Cost in the Role field. 

  

When the employee logs in: 
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The employee will get all of the programs and security settings to which he or she would otherwise have access. 

 

The exception is the employee pay rate data in Master File Employees which will show *** replacing the rate and 
cost. 
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Cost Accounting Using Monthly Job Feature/Labor WIP 
PrintStream has a Monthly Job Feature that when activated allows cost capture for non-chargeable activities 
which would otherwise not be accounted for. Non-chargeable activity costs cannot be passed on to the 
customer, but they still require resources, mostly labor, that can be tracked using the Monthly Job feature. 

To capture costs for non-chargeable activities 

1. Create a non-chargeable activity code in Master File Reports. 

2. To capture at a cost center level, activity must be set up under the cost center. 

 For a generic non-chargeable activity, activity may be set up under a miscellaneous cost center and be 
used to log time against any department. 
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3. Link Non-chargeable Activity to Reports. 

  

4. Activate Monthly Job Feature. 

  

Report 25 – Billing 
Worksheet – linked to 
Machine’s Cost/Labor 
Center 

Report 1000 – 
Standard Markups – 
linked to Labor 
Center 
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5. Create a Monthly Job using the Quick Job Program. 

  

6. Shop Floor Entry for Non-chargeable Activity. 

The job number may be entered or auto-
generated by PrintStream.  You may want to 
number the job to identify the month it 
represents – i.e. 200907 
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If the 
Monthly 
Job feature 
is used, no 
entry is 
needed in 
this screen.  
Clicking on 
the check-
mark loads 
the 
monthly 
job number 
you created 
in Quick Job 

Note that the monthly 
job number is loaded 
and shows no job 
activities.  All non 
chargeable activities 
will be under the 
‘Station’ tab. 
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Select the Station activity by clicking to 
highlight and then choose Ok. 
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Choose the machine on which the non 
chargeable activity is to be performed.  
You will need to set the machines up in 
Shop Floor if you wish to designate the 
machine in this transaction. 
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When non chargeable activity is 
complete, select name and click 
on ‘Your Started Activities.’ 
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Click on the activity listed  to highlight and 
then click ‘Ok.’ 
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Enter a count of one (1) and then select 
‘End.’ 

The cost for the non chargeable activity 
references the job number, start and end times 
and total hours. 
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And the billing worksheet for the monthly job 
number will display the costs. 
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7. If WIP Labor recording is used, there are these additional steps to setting up capturing non-chargeable 
activities using the Monthly Job Feature. 

8. In System Defaults, the second tab Posting to GL\Posting Labor to the WIP needs to be set. WIP 
posting option is set to hourly. 

  

9. Activate the setting below in this same screen. 

  

10. The WIP labor linking screen now contains a column that shows the chargeable / non-chargeable status 
of each activity code. This status is indicated with a red check box if chargeable. 

 An important note here is that linking of non-chargeable activities for posting follows different 
rules than chargeable. 

11. Time recorded to non-chargeable activity codes will bypass work in process altogether. The user can 
define the accounts they want to be affected by thinking of this linking screen as follows. 

The Shop Productivity Report shows this cost 
center at 66.67% productive.  I have 1.0 hour 
production run time and .5 hour downtime. 
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 The general ledger accounts defined in the WIP area control the g/l account that will be debited upon 
labor posting. 

 The general ledger accounts defined in the Applied are control the g/l account that will be credited up 
labor posting.  

12. The set up below where expense account 6060 appears in the WIP section is a likely way of defining 
non-chargeable linking. 

 Test case: 

 Activity code is linked as 

 01-01-01-2175 in applied labor – expected credit 

 10-01-8700 in WIP section – expected debit 

  

13. Timesheet entry will allow for look up and selection of activity codes that are defined as non-chargeable 
for these types of jobs only. 

14. Shopfloor program will provide an option to select house job for capture of non-chargeable, non- job 
related time. 

 Timesheet entry for 1 hour 
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15. Run labor posting routine. 

  

 No other posting occurs. 
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.Net Quote Breakdown Options 

Overview 
The new dot net quote breakdown report has many user defined variables. These variables allow you to create a 
custom report based on the information that you want to see displayed on the report. 

Setup 
This area requires the assistance of your Printstream Production support person. 

Setup Location = Master Files Reports > System Maintenance > System Defaults File > Mail Estimating 
Module 

 

The following areas are directly tied to the Quote Breakdown Report: 

Access Estimate Breakdown – checking this option activates the report so that it can be run directly from the 
Print and Mail program. 

Display Cost in Columns – this setting works with the setting below which says “Display In Columns Hours and 
Cost. If this setting is checked along with the setting mentioned the report shows costs in both the summary area 
and under the details for each quote. The selling price will only be displayed in the summary area of the report 
but not in any of the detail. 

Display Suggested Sell in columns – this setting works with the setting below which says “Display in Columns 
Cost and Sell.  With both of these options checked in the Summary area of the report you will see both cost and 
sell for each category defined and in the detail area you will only see selling prices for all details.  If only the 
selling is desired in the summary area also then select the option that says “Display in Columns Hours and Cost 
with this option. 

Display Cost Total – selecting this option adds a total cost field to the summary area of the report. If this is not 
selected the total cost field will not appear on the report. 

Display Suggested Sell Total – selecting this option adds the total selling price to the summary area of the 
report. If this is not selected the total sell price will not appear on the report. 
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Display Variance Total – selecting this option will show the variance amount in the summary area of the report.  
The variance amount represents the difference between the suggested selling price and the actual sell price 
indicated. This only happens when the suggested selling price on the quote has been manually overridden so it 
is different than the suggested sell price. 

Display Value Added Total – selecting this option will include the total value-added amount in the summary 
area of the report. Value added represents the suggested or actual sell price minus material costs and buyout 
costs. If this option is not selected it will not appear on the report. 

Display Profit Total – selecting this option will include the total profit amount in the summary area of the report.  
Profit is calculated by taking the suggested or actual sell price and subtracting the labor, material, and buyout 
costs on the estimate. 

Display Total Labor – selecting this option will include the total labor cost for each quantity in the estimate in the 
summary area of the report. If this option is not selected the total labor cost will not be displayed on the report. If 
this option is checked and you have the Display Cost and Sell option also checked, you will see both cost and 
sell for labor on the report. 

Category Defined by the Report Number 
This option allows you to define the report that you want to use for the categories that appear in the summary 
area of the quote breakdown report. By default, this report uses the categories as defined in report 1000 which is 
the Standard Markups report. If these categories are sufficient then no other setup is required here. The 
Standard Markup report which is used for marking the costs up by category to arrive at a suggested sell price 
has very strict linking rules. For example, if I have a line for Prepress on the report and it is flagged as a Labor 
line, only labor activities can be linked to that line. Creating a new report here gives you the ability to have 
different activity code types linked to the same line so in the example above I can have a Prepress line but can 
have all prepress activity costs including Labor, Material and buyouts linked to the same line. Here are the steps 
that need to be followed to setup a new report: 

1. Go to Master Files Reports > Master File Report (Tab) > Master File Report. 
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2. Click the Add button. In the Report Name field, type 1005 then in the field to the right enter New QB 
Estimate Summary Categories. In the Description field below, enter Quote Breakdown Estimate 
Summary Categories. In the Report to link to, select A Activity Codes from the drop-down listing, 
then click Save. 

 Your screen should look something like this. 

  

3. Click Details. Enter the line number, description, and activity type for the line here. You can have as 
many categories as you wish but our recommendation is that you keep it to ten or under. The LMS 
column which stands for Labor, Material, or Subcontract represents the type of activity codes that will 
link to this line. As mentioned earlier in this report, a line can be flagged as “L” for labor but will still allow 
other activity codes to be linked to it. Even though this is the case make sure you select a default 
activity type for each line. 

  

4. Each activity code can only be lined to one line in the report. When you have finished the report, click 
Save to save your lines. 
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5. Link the activity codes to the new report you created. Go to Master Files Reports > Master Files 
Report (Tab) > Report Links. Double-click the word REPORTS and you should see report 1005 in the 
list of reports. Click the + in front of report 1005 so you can see the lines on the report. 

6. Click a line in the report so that it is highlighted then click the number in front of the activity code or 
codes that you want to link to the highlighted line in the report. Click the button with the arrow pointing to 
the left and the highlighted activity codes will be linked the highlighted line. When the line is highlighted 
the activity codes that are linked to it will appear in blue. Continue linking until you have linked all of the 
print related activity codes to one of the lines you have defined. This report only deals with print related 
activities, so it is not necessary to link mail activities to the report. 

  

7. After you have finished linking the report, go back to Master Files Reports > System Maintenance 
(Tab) > System Defaults File. You will need to have your Printstream Production Support 
Representative get you back into this area. Enter report 1005 under the Mail Estimating Module tab 
under the Category Defined by the Report Number field. 

 This completes the setup for the user defined report categories. 
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Markup Markdown Chart 
This option is completely optional. It allows you to add a Markup/Markdown chart to the existing report. The 
markup/markdown chart uses the existing suggested sell price and either applies a user defined markup to the 
suggested sell or in the case of a markdown takes out the cost of material and buyouts from the suggested sell 
price before applying a markdown. It then adds the material and buyout cost back in to show the total markdown 
value. In this case the markdown is only applied to the labor part of the estimate. 

To setup the Markup/Markdown chart 

1. Using the same instructions as above for creating report 1005, create a new report, report 32, called 
List of Markup/Markdown % with a description of Markup Percentages for QB Markup/Markdown 
Chart. The Report to link to needs to be set to Categories And Codes for this report. See sample 
screen below. 

  

2. Click Details and enter the Line number, Markup or Markdown description, and the amount of markup 
expressed as a positive number or a markdown expressed as a negative number. Between the Markup 
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and Markdown lines you can add a line which represents the suggested sell price enter O for the Code 
on this line. 

  

3. Click Save when you are done. 

 After completing this step, when you run the Quote Breakdown Report, you will see this chart added to 
report. 
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Packages Advanced Feature 

Overview 
This is new .NET Programming that allows users to set-up Packages and link Components and Processes all 
within one user-friendly screen. This takes the place of entering each package within an estimate/job and 
selecting the P button to link processes. 

We have also included additional fields: Weight, Size, Thickness, and Aspect Ratio that will calculate Postal 
Qualification. This option will allow the user to identify if the piece qualifies as Postcard, Letter or Flats and 
automation as well. For example, a customer could provide piece specs for a printed item. The client service 
representative can set-up the information in Packages Advanced and right away determine automation 
compatibility. This could potentially save the customer additional postage by redesigning the mail piece. 

Procedures and Use 

The Packages Advanced program is located in the Estimating Branch. This will require your assigned support 
representative to activate. 

 
Selecting Packages Advanced opens the following screen: 

 

User has options to select the icons when creating, saving, deleting or printing packages.  
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To create a package 

1. Select New.  

 Package Number –Auto populates 

 Package ID –Auto Populates 

2. Enter a Package Name. 

3. Select a Package Type (user has option to create package samples). 

4. Enter a Quantity. 

 # of Pieces in PKG. – Auto populates based on Components selected for the package. 

 Notes – User define  
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Production Status 
New –New Package 

OK to Released to Customer – Is package ok to be released to the customer for approval? 

Customer Approved – Customer approved Package. 

Customer approved with changes- Customer has approved package but with changes. 

Presorted – is this a presorted package? 

Pkg. Status – Unlocked/Locked –User has the option to Lock or Unlock package information. When status is 
changed and Saved the fields cannot be edited unless package is Unlocked. 

Counts Confirmed – YES/NO  

Mail 100% - YES/NO – For example the customer may or may not require spoilage to be re-printed and mailed. 
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Presort Wizard 
Entry Point Name - Postal facility at which mail enters the postal delivery system. 

Entry Point Zip – Zip Code of the Entry Point Postal facility.  

Package Size – Height x Length 

Aspect Ratio -the dimension of a mail piece expressed as a ratio of length divided by height (for letters and 
cards, length is the dimension parallel to the address as read). For example, a #10 Envelope 4 1/8 inches long 
by 9 ½ inches high has an aspect ratio of 2.30. An aspect ratio between 1.3 and 2.5, inclusive, is required for 
automation compatibility. 

Piece Weight – Total weight of pieces in package. 

Package Thickness – Thickness of pieces within package. 

Package Tare Weight-Actual, computed, or estimated weight of the container and/or packaging. 

Flap Opening Edge – long edge (length of envelope, parallel to the address block) or edge (perpendicular to the 
address block) on a typical #10 envelope. 

Address Format – Across Long Edge (address appears on the long dimension of the envelope) or Across Short 
Edge (address appears on the short dimension of the envelope. 

Mailing Scheme – How mail is being prepared, example –First Class, Carrier Route, Presort…. 

Postal Qualification – Select this option after entering Package Size, Piece Weight and Package Thickness. 
This will allow the user to identify the postal qualification of the piece. 

In this example based on the package specs this piece qualifies as Letter Auto. 
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Physical Dimensions- can be edited in the screen, upon making changes select Qualify to review new results.  

Show Specifications in the result – This option displays postal qualification specs in each field. 

Print – User has option to print this document. 
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Link Components to Package 
1. Select the Package Components tab. 

  

2. Components can be added to the package using the drop-down in the Component column or right-
clicking and adding multiple components. 
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3. To add an additional Component, select (Component) column and a new line will appear with drop-
down option. 

  

4. For a quicker way to add components to a package, right-click in the blank line under the Component 
column and select Add Multiple Component Links. Components Links can also be deleted. 
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5. Place a check for the components that are required for the package and Save. 

  

 Many of our.NET programs provide the user the ability to drag columns for grouping. This allows 
columns to be sorted. 

  

 User also has the ability to move columns. 
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6. Select Column and drag to re-order display. 

  

 In the example below, the component selection (check box) has been placed to display first. 
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 Components linked to the package  

  

  

 Component – Piece linked to the package. 

 Qty. – Component package qty. This can be edited for each component. 

 Insert Seq. – Order in which package is put together. 

 Outer Envelope –Yes/No – Drop-down selection 

 Personalize – Is the component a personalized letter. Place Check mark for selection. 

 Files the Package – Which component contains the addressed piece. For example, Personalize letter 
into window envelope, letter will fly the package. Inkjet closed face envelope that contains generic letter, 
Envelope will fly the package. 

 Insert Direction – Multiple Choice, (Faces Flap or Faces Face) 

 Affix To – Allows the component to be affixed to another component. For example Post It Note can be 
affix to the letter in the package. Choose component and left click in the (Affix To) column a list of 
package components will display for selection. 

 Notes – Free Flow field. 
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Link Processes to Packages 

After Package Components have been completed, select the Package Processes tab. This will allow processes 
to be selected and linked to the package. 

 

Same rules apply as Package Components. Processes can be linked using the drop-down in the process 
column One at A Time or right-clicking in the blank column under Process Multi Process Selection. 
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Select Processes for the package and click Save. 

 

Save the Package. 
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Additional Options – Right-click the package or within blank space and list of options will display. This is 
another option to Add, Delete, Copy, or Create Sample Packages. Users may elect to use this method rather 
than selecting from the Icons. 
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End Results 
Example of Package created using Packages Advanced/ Package Components tab.  

 

Processes are linked to the Package- This is achieved by the Package Processes tab in Packages 
Advanced. 
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Rates Setup Table Data Dictionary 
What is the name of the table where the rates from the Rates Setup Table are stored? 

JOBPROC 

The JOBPROC table holds the values of all activities in the system. This includes the rates that are entered in 
the Rates Setup Table in MasterFile Reports > Production System. 

 

 



60  EFI PrintStream | User Guide 

 
 

 

Scanners and Touch Screens 

Overview 
This is a selection of example scanners and touch screens to help give you some idea of what technology 
Streamline or our customers have used or recommended in the past. Streamline does not endorse one product 
over the other and is not in the business of selling or reselling scanners, touch screens and relate peripherals. 
This does not however mean that Streamline leaves to fend for yourselves in this arena; if you need assistance 
with compatibility, protocols, or advice with standards, methodologies etc. Streamline resources can be 
leveraged and made available you.  

Streamline recommends collaborating with a local dealer that will work with you to achieve your desired results. 
We suggest that you partner with an organization that is willing to roll up its sleeves to find solutions that fit in the 
context of your operations. The folks that manage your operations should be able to “test drive” products in order 
to make the right decisions. 

If your company is a member of the PrintStream user group, polling the users is another avenue to which you 
have access. Discover what products and technologies fellow members are currently utilizing, and what dealers 
and manufacturers are providing the best solutions and best value.  

Shop Floor: Barcode Scanner 
WASP 

- WASP Model No: UF-101E 

- 100237 - WASP CCD KBD WEDGE SCANNER 

 

Vendor: System Warehouse ID (888) 648.4452.  

http://www.systemid.com/index.asp 

Symbol Cobra 

The Symbol Cobra LS1902T, Symbol LS1902 KB WEDGE KIT SCAN - model # SMB-LS1902T-I000-3000S or 
the Symbol lS1908 (lower price). 

 

http://www.cdw.com/shop/products/default.aspx?EDC=312201 
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Adaptus 
3800g General Purpose Linear Image Scanner: 

 

http://www.handheld.com/Site.aspx/na/en/product_center/hardware/?product=136 

Shop Floor: Touch Screens 
MicroTouch by 3M 

 

Some of our customers use a touch screen product called MircoTouch by 3M. 

http://www.3m.com/3mtouchsystems/ 

Barcode Gun vs. Wand, Pros and Cons 

Barcode Gun 

The user holds the barcode gun in their hand and needs to grip the handle to press the barcode 
trigger. 

Advantage – the barcode scan can be done from a short distance; it is easier to shoot a barcode that 
may be printed on a card or sheet close to the monitor. It is also a “nonabrasive” process, meaning 
the scanning does not wear on standard barcodes, requiring they be reprinted due to wear when the 
barcodes become unreadable. 

Disadvantage – the user must have a firm grip on the gun which generally is held with the same hand 
that is used to perform touch screen or keyboard commands, requiring that the gun be set down to 
free the hand for these other tasks. The second disadvantage is that the wrong barcode could be 
scanned if the aim is not accurate. 

Wand Barcode 

Advantage – the wand is held in the hand between thumb and forefinger like a pen where other 
fingers on the same hand are free to press keys on the keyboard or the touch screens without the 
need to set down the pen. Because of the close proximity of the scan which requires touching the 
barcoded material, there may be less chance of shooting the wrong barcode because of the angle of 
projection on the bar code gun devices. 

Disadvantage - the barcode scan has to be done in close proximity to the barcode – often meaning 
the barcode itself is physically touched during the swipe. This can have an “abrasive” effect on the 
barcode and may require frequent reprinting of standard barcodes (e.g. barcodes for non-chargeable 
activities and barcodes represented on the ‘Standard Command Sheet’ in the Print128 program). 
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Best way of testing the accuracy of the two devices is as follows: 

Open Microsoft Word and just start “blasting” away at different barcodes with a barcode gun device. Scan as 
quickly as possible and then look at the resulting text in the word document.  

Read the list of text and check the accuracy of each scan. This will show how accurate and fast the scans are. 
Now repeat the exercise with the wand and check the accuracy and speed of the wand method. 

Scheduler - Special Events 

 

Special Events can be setup in Master Files Reports > Master File Report > Report #625. Select the Details 
button and enter Line, Description, and check Total and Save.  
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The Industry Performance Profile Program 
The Industry Performance Profile Program has been added to PrintStream to help MFSA members who 
participate in the association's annual "Performance Profiles" financial ratio survey enter the information much 
more easily. Once you have established the links between the MFSA categories and your PrintStream accounts, 
you can create and export this data over and over. 

One of the biggest challenges most companies face when filling out the financial data for the survey is compiling 
and entering the data. Now, with this program, MFSA members simply need to correlate the appropriate G/L 
accounts for each of the items requested in the survey and the program will do the calculations. Then, when the 
forms are returned to the survey firm, the user need only include a diskette with the data generated by the 
program (along with the hard copy of the form for those few non-financial bits of information requested.) 
Companies participating in the survey will find this program to be a tremendous time-saver and MFSA should 
benefit as more companies are now able to fill out and complete the data in less time.  

Log into the program called Industry Performance Profile 
You may have to add it to one of the Program Groups in your menu by using the Menus and Users program. 
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When you get into the program, this is the screen you will see. You will need to import the MFSA supplied 
Number Links and Descriptions using a text file supplied by MFSA or Streamline Solutions. Then you will define 
the links between the MFSA items and their corresponding locations in your PrintStream Chart of Accounts. 
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Billing Worksheet Mockup 
 Job # _____________ 
 Customer # _____________ Customer Name ______________________  Job Title ___________________________      Job's QTY – ____________  

QuoteNo Customer # Invoice # Last Inv Date Job's Sales Person PO Number(s) Repeat New 
1465.99   NELS 10939* 10/25/2009 Andrea Cox 389 , No Yes 
Cost Center $ Estimate $ Actual $ Difference Labor Center $ Estimate $ Actual $ Difference Est. Hrs Act. Hrs 

DP & Prepress  Buyouts 127.50 127.50  DP & Prepress 776.00 778.00 2.00 12.60 12.70 
Laser Buyouts    Print 5,024.29 3,730.50 -1,293.79 28.72 22.80 
Print Buyouts    Laser 1,472.14 1,542.00 69.86 24.53 25.50 
Bindery Buyouts    Burster      
Mailing Buyouts    Bowe      
Fulfillment Buyouts    Cutter      
--------------------------------    Folder      
Total Buyouts 127.50 127.50  General      
--------------------------------    Ink Jet      
DP & Prepress  Mat'l 9.00 9.50 0.50 Cheshire      
Envelopes    Piggy Back      
Paper 822.46 822.46 0.00 Inserter 4,835.00 4,480.00 5.00 44.50 88.00 
Laser Mat'l    Stretch Inserter      
Bindery Mat'l 235.37 242.18 6.81 Poly Insert      
Mailing Mat'l    Handwork      
Fulfillment Mat'l    Sorting      
--------------------------------    Waferseal      
Total Raw Materials 1,066.83 1,074.14 7.31 Stamping      
--------------------------------    Postage Prep      
Freight    Saddlestitch      
Postage    Fulfillment      
    XML      
    Warehouse      
    Shipping labor      
Material Cost 1,194.33 1,201.64 7.31 Labor Cost 12,107.43 10,890.50 -1,216.93 110.36 149.00 

Material Sell 1,358.82 1,201.64 164.49 Labor Sell 11,904.54 10,890.50 -205.89   

Markup %13.77 %0.00  Markup -%1.70 %0.00    

Projected P&L Based on Quoted Price and Actual Cost Actual P&L Based on Actual Cost & Invoice 
Actual Totals Variance Labor Material Markup Actual Totals Labor Material 
Total 
Costs $12,092.14 X 10,890.50 1,201.64  Total Costs before A/C $12,092.14 10,890.50 1,201.64 

- NonChg $0.00 X 0.00 0.00 X - NonChg $0.00 0.00 0.00 
- Rework $0.00 X 0.00 0.00 X - Rework $0.00 0.00 0.00 
= Charges $12,092.14 X 10,890.50 1,201.64  Charge Cost before A/C $12,092.14 10,890.50 1,201.64 
Quoted At $13,260.36 0.00 12,107.43 1,194.33 -41.40 + A/C's $0.00 0.00 0.00 
+ A/C's $0.00 X 0.00 0.00 0.00 = Billable Cost $12,092.14   
- Billed $13,260.36 Freight Billed: 0.00 X X - Billed Invoices $13,260.36 Freight Billed: 0.00 
= Invoice $0.00 X X X X     
Profit/Loss * $1,168.22   W/O Rework With Rework  
   Profit/Loss* Actual $ $1,168.22 $1,168.22  
   Value Added $ $12,058.72 $12,058.72  
   Value Added % 90.94% 90.94%  
   Net Profit % 8.1% 8.81%  

 * Profit /Loss  is calculated as a difference between Actual Total Cost Amount and (Actual Billed Amount plus amount which is still unbilled to the customer based on the Quoted Amount and Authors Corrections).  Billed Amount  does 
not include tax or postage. Including freight billed is an optional setting. 
**On the BWS report all amounts are in GL Currency   

 Estimated Price for Buyout from the Estimate Final Pricing Screen 

 Actual Price from Purchase Order 

 Estimated Cost for Labor from Print Quote Breakdown Labor Center $Cost + Pricing Summary ‘Process’ Cost Total from the Final Pricng Screen Less Buyout; est. hrs. from 
Estimate 

 Estimated Cost for Material from the Print Quote Breakdown Material/Purchase $Cost + Buyout 

 Actual Cost of Labor – hours recorded in ShopFloor or Timesheet multiplied by hourly rate from the Activities Setup in MF Reports (unless other multiplier is selected in BWS options, 
i.e. selecting ‘Use Labor Rate for Actual Cost’ option when the Labor Rate is used in place of the Hourly Rate) 

 Actual Cost of Material from the Material Issues to the job 

 Estimated Labor Sell Price from Print Quote Breakdown Labor Center $Sell + Pricing Summary ‘Process’ Quoted Total from the Final Pricing Screen Less Buyout(s) 

 Actual Material Sell is Actual Material Cost from Material Issues to the Job (including Buyout(s) + Markup 

 Estimated Material Sell from Print Quote Breakdown Material/Purchase $Sell  Plus Buyout(s) 

 Markup $ Amt. difference between Labor Cost and Labor Sell, and Material Cost and Material Sell 

 Labor + Material Markkup 

 Actual Labor Sell Price is Actual Cost of Labor from Labor Transactions charged to the Job + Markup  

 


